
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

LiftView™ System 
 

User’s Guide to LiftCentral™ Software 
 
 
 
 

 
SIRIUS International (Hong Kong) Limited 

 



 

 
 
This manual contains installation and operating instructions for the LiftCentral™ software. 
 
© 1999-2004 Sirius International (HK) Ltd. 
16/F, Futura Plaza, 
111 How Ming Street, 
Kwun Tong, Kowloon, 
HKSAR. 
All Copyrights Reserved. 
 
 

 



 

TABLE OF CONTENTS 
 
Table of Contents i 
Congratulation 1 
Read This First! 2 
LiftView™ System Components 3 
Part 1 How to Install LiftCentral™ Software? 4 

 Minimum Requirements of Your Computer 4 
 Installing LiftCentral™ Software 4 

Part 2 The Launch and Tour 6 
 Starting LiftCentral™ through the START Button 6 
 Starting LiftCentral™ with a File 6 
 A Tour of the LiftCentral™ Screen 7 

Part 3 Common Functions of LiftCentral™ 10 
 Creating New Document 10 
 Opening Existing Files 10 
 Option 10 
 Saving Active Document 11 
 Inserting New Message / Slot 11 
 Deleting Existing Message / Slot 12 
 Port Setup for Uploading File to Your System 12 

Part 4 Using LiftView Message File in LiftCentral™ 13 
 Introduction of LiftView Message File 13 

View of Document Window 13 
File Setting for LiftView Message File 13 
What are the message categories? 15 

 How LiftCentral™ changes message properties 15 
Changing message properties of a message 15 
Changing message properties of a group of messages 17 
How to use graphic mode to modify a message? 18 
How to change the font format of messages? 22 

Part 5 Using LiftSpeaker Sound File in LiftCentral™ 23 
 View of Document Window for LiftSpeaker Sound File 23 
 How LiftCentral™ changes slot properties? 23 

Part 6 Introduction of Uploading Media 25 
 RS-232 to RS-485 Converter 25 
 Infrared Medium (Ir Medium) 26 

Part 7 Uploading LiftView Message File Via Different Media 27 
 Uploading Floor and Alarm Messages via RS-232 to RS-485 Converter 27 
 Uploading User Message via RS-232 to RS-485 Converter 28 
 Stop Showing User Message 29 
 Uploading Floor and Alarm Messages via Ir Medium 29 

Part 8 Uploading LiftSpeaker Sound File Via Different Media 31 
 How do you create sound ROM? 31 
 Uploading via RS-232 to RS-485 Converter 32 
 Uploading via Ir Medium 33 

 
 

i 



 

CONGRATULATION 
 
Congratulations and thank you for your interest in the first total solution of the lift indicator control system, 
LiftView™ System.  Our goals are to: 
 
 handle the lift indicator control system easily; 
 reduce the maintenance cost of the lift indicator control system; and 
 make friendlier floor indicator for passengers. 

 
We trust that you would enjoy choosing this system for your lift project.  Should you need any further 
assistance please feel free to contact us via the following channels: 
 
 
Sirius International (HK) Limited 
16/F, Futura Plaza, 
111 How Ming Street, 
Kwun Tong, Kowloon, 
HKSAR. 
Attn. : Technical Support Dept. 
Tel. : 2749 9825 
Fax. : 2398 7605 
E-mail : info@siriushk.com

1 

mailto:info@siriushk.com


 

READ THIS FIRST! 
 
If you are new to LiftView™ system, start with the following topics: 
 
 What are the components of LiftView™ system? 
 How to install LiftCentral™ software? 
 Tour of LiftCentral™ screen. 
 What are LiftView Message File and LiftSpeaker Sound File? 
 How LiftCentral™ creates LiftView Message File and LiftSpeaker Sound File? 
 What are the message categories for LiftView Message File? 
 What is the slot of LiftSpeaker Sound File? 
 Uploading media will be used. 
 How to use LiftCentral™ to upload information to LiftView™ display board? 
 How to use LiftCentral™ to upload information to LiftSpeaker™ digital voice announcer? 
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LIFTVIEW™ SYSTEM COMPONENTS 
 
LiftView™ system includes the following software and hardwares: 
 
 LiftCentral™ software; 
 LiftView™ display boards; 
 LiftSpeaker™ digital voice announcer; and 
 LiftMaster™ signal controller. 

 
LiftView™ System enables you to modify messages or send user message, one at a time, to LiftView™ 
display boards and handle pre-recorded announcements (e.g. arrival gong, floor announcements, etc.) to 
LiftSpeaker™ digital voice announcer with bundled editor. 
 

 
 
LiftCentral™ software is a user-friendly editor, which is Windows 95/98/SE compatible, for users with 
access to PC.  Moreover, it is suitable for all countries, accepting characters such as Japanese, English or 
Chinese.  It runs on a Host PC connected via RS-232 to RS-485 converter to one or more LiftMaster™ 
controller(s).  User may: 
 
 Modify message contents; 
 Update the programmable ROM in LiftView™ displays to suit lift controllers and satisfy display 

content requirements; and 
 Send real-time messages to LiftView™ display board. 

 
RS-232 to RS-485 converter acts as an interface between the Host PC and the LiftMaster™ controller. 
 
LiftMaster™ signal controller, which decodes signals from a lift controller, and updates attached 
LiftView™ displays accordingly.  It has the following features: 
 
 Relays lift signals to LiftView™ display boards; 
 Separate connection for LiftView™ display inside lift cabin to eliminate transmission error from 

interference; 
 Controls up to 256 LiftView™ displays, at a maximum distance of 4,000 feet. 

 
LiftView™ display board is a display module designed for lift landings and the interior of lift cabins.  It is 
capable of simultaneously displaying travel direction (up or down), floor level and alarm messages.  
LiftView™ display boards can be divided into groups, with arbitrary groups prevented from displaying 
certain messages. 
 
LiftSpeaker™ digital voice announcer is a stand-alone module.  It works in conjunction with LiftView™ 
display board to broadcast lift levels and other pre-recorded announcements. 
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HOW TO INSTALL LIFTCENTRAL™ SOFTWARE? 
 
Minimum Requirements of Your Computer 
 Windows 98/SE 
 32MB RAM 
 Pentium 133 
 4X CD-ROM drive (for CD installation) 
 44MB floppy drive (for floppy installation) 
 Mouse or tablet 
 SVGA graphics 
 5MB free hard disk space 

 
 
Installing LiftCentral™ Software 
This section will walk you through LiftCentral™ Setup.  If you have a previous version of LiftCentral™ on 
your system, select the same directory.   When prompted for where LiftCentral™ should be installed, 
make sure that you have backed up important files (e.g. *.lvm and *.lvs). 
 
To start the installation of LiftCentral™: 
 
1. Depends on the format of the installation medium: 

 Installing from the Floppy: Insert the LiftCentral™ diskette into your floppy drive. 
 

 
Figure 1-1 

 
From the Windows 98 desktop, click on the Start button and then choose the Run command. 

 

 
Figure 1-2 First level of the Start menu 
 
Select the drive letter from which you will be installing LiftCentral, and type LiftCtrl140.exe. 
 

 
Figure 1-3 Run dialog box for floppy installation from A: drive 

 
 Installing from the CD: Insert the LiftCentral™ CD-ROM into your CD-ROM drive.  Your 

CD-ROM autoruns the CD.  If not, you need to do the same steps of installing by floppy. 
 

 
Figure 1-4 
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2. When the LiftCentral™ Installer dialog box appears, you are ready to install LiftCentral™.  Click on 
the Install button.  Figure 1-5 shows the installation dialog box. 

 

 
Figure 1-5 LiftCentral™ Install dialog box 

 
3. You will be prompted to select the folder into which LiftCentral™ will be installed.  Check to see if the 

default folder is acceptable to you.  You can choose to change the folder, choose Cancel to exit, or 
choose OK to continue.  If you choose to change the folder, you can install LiftCentral™ to another 
folder on the same drive or on another drive, even a network drive.  Figure 1-6 shows the Installation 
Folder dialog box. 

 

 
Figure 1-6 LiftCentral™ allows you to change where you want the installation to occur. 

 
If the folder does not exist in your drive, you will be prompted to create it.  Click OK to continue the 
installation. 

 

 
Figure 1-7 Prompted to create new folder for LiftCentral™ 
 
If the folder does exist, you will need to confirm overwriting the existing version of LiftCentral™ on your 
computer. 
 

 
Figure 1-8 Prompted to ensure overwriting the existing version of LiftCentral™ 

 
4. Once LiftCentral™ has been installed, a dialog box will prompt you to restart your computer.  
 

 
Figure 1-9 Prompted to restart your computer 

 
You restart your computer or not, a dialog box shows you that the installation process is finished. 

 

 
Figure 1-10 Inform you the installation process is finished 
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THE LAUNCH AND TOUR 
 
Windows offers many ways to start your applications.  For example, you can start LiftCental™ by 
launching it from the Program item on the Start button menu, or you can activate a LiftCentral™-created 
file from the Documents item on the Start button menu.  In this part, we will present two possible ways in 
which you can start LiftCentral™. 
 
 
Starting LiftCentral™ through the START Button 
To locate and start LiftCentral™: 
 
1. Click on the Start button. 
2. Point to the Programs folder on the Start menu. 
3. Point to the LiftCentral™ folder on the Program menu. 
4. Click on LiftCentral under the submenu to launch the program. 
 

 
Figure 2-1 Windows 98 Start button and program menu system 
 
Starting LiftCentral™ with a File 
On the Start menu, you can see a Documents folder.  Point to this item to see the names of the most 
recent files you created or opened using Windows.  If you click on a filename that was created using 
LiftCentral™, LiftCentral™ will launch from there.  This feature allows you to quickly start both the 
program and the file you last worked on. 
 

 
Figure 2-2 Windows 98 Documents folder 
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A Tour of the LiftCentral™ Screen 
In this part, we will describe LiftCentral’s default appearance.  To see the screen shown in Figure 2-3, click 
on the New button (the first button on the left) located on the Toolbar. 
 
A dialog box appears that reads Select New Document Type.  You will be prompted to select which type 
of file you want to create.  There are two types of file: LiftView Message File and LiftSpeaker Sound 
File. 
 

 
Figure 2-3 Open new file 

 
LiftView Message File stores the information of messages (e.g. lift controller’s triggering number, floor 
level, alarm messages and user message) that will be displayed on the LiftView™ display board. 
 
If you select LiftView Message File, you can see the screen as shown in Figure 2-4. 
 

 
Figure 2-4 File of LiftView™ display board 

 
LiftSpeaker Sound File stores the information of announcements (e.g. lift levels) that will be broadcasted 
by LiftSpeaker™ digital voice announcer. 
 
If you select LiftSpeaker Sound File, you can see the screen as shown in Figure 2-5. 
 

 
Figure 2-5 File of LiftSpeaker™ digital voice announcer 
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Starting at the top of the window are three rows of objects: Title bar, Menu bar and Toolbar.  Below these 
upper rows is the opened document.  A Status bar is shown below the opened document.  The following 
paragraphs describe the identified items as shown in Figure 2-4 and 2-5. 
 
Title Bar 

 
 
The title bar is located along the top of the application window.  It displays the name of the application and 
that of the document. 
 
To move the window, drag the title bar.  (Note: You can also move dialog boxes by dragging their title 
bars.) 
 

 
 
You can use the icons on the right hand corner of the title bar or Alt+ F4 to close the application window.  
LiftCentral™ prompts you to save documents that have unsaved changes. 
 
The following icons are on the right of the title bar: 
 
Click To 

 Minimize LiftCentral™ and a document window 
 Maximize LiftCentral™ and a document window 
 Exit LiftCentral™ or Close document window 

 
Menu Bar 

 
Menu bar for LiftView document 
 

 
Menu bar for LiftSpeaker document 
 
The menu bar displays the names of the menus (lists of commands) in LiftCentral™.  You can activate a 
menu by clicking at its name with the mouse, which drops down the list of commands. 
 
If you prefer to use keyboard commands over the mouse, there are key combinations for activating each 
menu: hold down the “Alt” key and tap the key for the underscored letter of the menu bar item.  For 
example, Alt+F will activate the File menu. 
 

  
 
You can use the icon on the left hand corner of the menu bar or Ctrl + F4 to close the document window.  
LiftCentral™ prompts you to save documents that have unsaved changes. 
 
Toolbar 

 
 
The toolbar is located across the top of the application window, below the menu bar.  The toolbar provides 
quick mouse access to some of the most common commands in LiftCentral™, e.g. File Open. 
 
Click To 

 Open a new document. 
Shortcut : Ctrl+N 

 Open an existing file.  LiftCentral™ displays the Open dialog box, in which you can locate and 
open the desired file. 
Shortcut : Ctrl+O 
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 Save the active document or template with its current name.  If you have not named the 
document, LiftCentral™ will display the “Save As” Dialog Box. 
Shortcut : Ctrl+S 

 Setup the file properties e.g. the model of LiftView™ display board, the display colour of message 
or arrow. 

 Transfer the floor message and alarm message to the display board. 
Shortcut : Ctrl+M 

 Upload the user message to the display board. 
Shortcut : Ctrl+D 

 Stop showing the user message on the display board.  The user message is being shown until 
you press this command that will cancel the show command of user message. 
Shortcut : Ctrl+T 

 Change the font size and type for different message categories. 
Shortcut : Ctrl+F 

 Remove selected data from the document and store it on the clipboard. 
Shortcut : Ctrl+X 

 Copy the selection to the clipboard. 
Shortcut : Ctrl+C 

 Insert the contents of the clipboard at the insertion point. Shortcut : Ctrl+V 
 Display the copyright notice and version number of LiftCentral™. 
 Press for help on some particular parts in the window. 

 
Status Bar 

 
 
The status bar is located at the bottom of the application window.  It describes the action to be executed 
by the selected menu item or pressed toolbar button, and keyboard status.  A check mark appears next to 
the menu item, when the status bar is displayed. 
 
The left area of the status bar describes actions of menu items as you use the mouse to navigate through 
menus.  Similarly, this area shows messages that describe the actions of toolbar buttons as you press, 
before releasing them.  If after viewing the description of the toolbar-button command you wish to void the 
command, then release the mouse button while the pointer is off the toolbar-button. 
 
The right area of the status bar indicates which of the following keys to be pressed: 
 
Description of indicators: 
 
CAP  The Caps Lock key is pressed. 
NUM The Num Lock key is pressed. 
SCRL The Scroll Lock key is pressed. 
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COMMON FUNCTIONS OF LIFTCENTRAL™ 
 
As you work in LiftCentral™, you will find that there are several functions common to both types of file.  
These functions include: 
 

 Creating new document; 
 Opening existing files; 
 Saving active documents; 
 Inserting new message / slot; 
 Deleting existing message / slot; and 
 Port setup for upload file to your system. 

 
The following paragraphs will describe the above functions. 
 
 

Creating New Document 
When you begin a new LiftView Message File or LiftSpeaker Sound File in LiftCentral™, a page appears 
with the generic name lv_msg# (as in lv_msg3) or lv_snd# (as in lv_snd2) respectively in the title bar.  
This is how LiftCentral™ refers to the file until you save your work with a better name. 
 
You can use  icon from the toolbar, or “New” command in File menu from the menu bar, or shortcut key 
“Ctrl+N” to start a new file. 
 
 

Opening Existing Files 
When you want to open an existing document in LiftCentral™, you can use  icon from the toolbar, or 
“Open” command in File menu from the menu bar, or shortcut key “Ctrl+O”.  A dialog box appears that 
shows you the names of files you have stored, listed in alphabetical order. 
  

 
Figure 3-1 Prompted to select file 
 
You may open multiple documents, you can use the functions in the Window menu from the menu bar to 
switch between multiple open documents. 
 
Option Description 
Look in  Select the drive and directory in which 

LiftCentral stores the file that you want to 
open 

File name Double-click on the filename that you wish to 
open.  This box lists files with the extension 
that you select in the List Files of Type option

List for files of type By default, the file list shows only the LiftView 
Message files, but you can select to see files 
of different type, e.g. *.lvm, *.lvs 
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Saving Active Document 
While you save your document the first time, you must name the document.  However, if you think that 
you might be sharing documents with other individuals who are using previous versions of LiftCentral™, 
you should restrict your name to 8 characters only, without space or periods.  If you have already named 
and saved your document, LiftCentral™ will simply replace your old saved version with the new version on 
the screen. 
 
You can use  icon from the toolbar, or “Save” command in File menu from the menu bar, or shortcut key 
“Ctrl+S” to save the active document. 
LiftCentral™ displays a dialog box that is Save As dialog box.  At the bottom of the dialog box is a text 
area designated for the filename.  Click in the File name area and type the name for your document.  
After you have typed the name of your document, click the Save as type and select the type of file.  Click 
the Save button on the right hand side of the dialog box.  If the active document is not the first time to 
save, use the “Save” command to save it.  It will save with its current name and directory. 
 

 
Figure 3-2 Save as dialog box 
 
If you want to make a copy of your existing document and work on the copy, use the “Save As…” 
command in File menu from the menu bar.  In the Save As dialog box, enter a new name for your 
document.  You will have two documents: one under is the old name and one under is the new name. 
 
 
Inserting New Message / Slot 
When you want to insert a new message / slot in the document, use “Insert” command in Message menu / 
Slot menu from the menu bar, or shortcut key “Ins”. 
 
When you insert message to the document, LiftCentral™ will display the Message Properties dialog box. 
 

 
Figure 3-3 Inserting a new message 
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When you insert slot to the document, the document will directly insert a new slot.  You need to open the 
Slot Properties dialog box. 
 

 
Figure 3-4 Inserting a new slot 
 
Therefore, you can type in the message / insert sound file, setup the event of message / slot you wish, to 
which display groups the message to be sent, etc. 
 
 
Deleting Existing Message / Slot 
If you want to delete an existing message / slot, you need to highlight that message / slot.  Then you use 
“Del” command in Message menu / Slot menu from the menu bar, or shortcut key “Delete”.  LiftCentral™ 
displays a dialog box, which asks if you really want to delete that message / slot. 
 

 
Figure 3-5 Ensure you want to delete that message 
 

 
Figure 3-6 Ensure you want to delete that slot 
 
If you press “Yes”, LiftCentral™ will delete that message / slot.  If not, the process will be cancelled 
automatically. 
 
 
Port Setup for Uploading File to Your System 
Before you upload the file to the device, you need to setup your output port, which is RS-232 serial port.  
The list box in figure 3-7 allows you to specify the COM Port.  The identified COM Port of the PC is 
connected to the RS-232 to RS-485 Converter or infrared uploader. 
 

 
Figure 3-7 Setup output port 
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USING LIFTVIEW MESSAGE FILE IN LIFTCENTRAL™ 
 
As you start to work on LiftCentral™, you need to open a new document.  There are two types of file: 
LiftView Message File and LiftSpeaker Sound File.  Predecessor is used in the LiftView™ display 
board.  Successor is used in LiftSpeaker™ digital voice announcer.  LiftCentral™ can create both types 
of file.  Let’s go to start LiftView message file type. 
 
 
Introduction of LiftView Message File 

 
Figure 4-1 The document window for LiftView Message File 
 
View of Document Window 
Starting at the top of the document window are several columns: Message Text column, Short Name 
column, Event column and Group Selection column. 
 
File Setting for LiftView Message File 
As you start to work in LiftView Message File, you need to setup the file format of the file.   icon from 
the toolbar, or “Settings…” command in File Menu from the menu bar can help you to setup file format of 
LiftView Message File. 
 
The following options allow you to specify the model of the LiftView display board and the colour for 
different display information. 
 

 
Figure 4-2 File setting dialog box 
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Model of LiftView Display Board 
LiftView display board is available in different models, such as LV-48.16, LV-64.16, LV-96.16, LV-144.16 
and LV-176.16.  Therefore, you must choose suitable models for your lift systems. 
 
Notes: LV-10.07-VL series, LV-10.14-VL series, LV-16.16-M series, LV-16.32-M series and LV-32.16-M series display boards are 
not available in the list.  Because the upload function for model of display board supplied in the list, it also uploads the message to 
the above series display board at the same time. 
 
LiftMaster Selection (Optional Function) 
If you have not selected this option before doing upload process, floor and alarm messages will be 
uploaded to all LiftMaster™ signal controllers that are connected to the same RS-485 converter. 
 
This will affect upload process, if selected.  While this option is selected, the dialog box is changed. 
 

 
Figure 4-3 Changed file settings dialog box 

 
This function is used to upload message individually.  You must input the LiftMaster’s ID, since a RS-485 
converter can be connected to a few LiftMaster™ signal controllers.  The ID is marked on the firmware. 
 

 

LiftMaster’s ID 

Figure 4-4 LiftMaster’s ID 
 
Colour for Different Type Information 
Each option provides three colours for you to choose.  They are RED, GREEN and AMBER.  The default 
colour of all display information is RED colour.  Therefore, this function is suitable for DUAL colour 
LiftView™ display board.  As you can choose particular colours for different types of information, such as 
floor message, alarm message, short name and up / down arrow. 
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What are the message categories? 
From the document window, you can see three types of message in the Message Text column.  These 
are: 
 

 Floor messages include floor level and travel direction of the lift cabin.  It is a fixed display in the 
center of the LiftView™. 

 Alarm messages include overload warning, lift malfunction alarms, fireman messages, etc.  The 
display mode of them is scrolling. 

 User message is real-time message.  It can be displayed inside and/or outside the lift cabins 
immediately.  The display mode here is scrolling. 

 
Floor and Alarm messages use the same type of method to upload to the LiftView™ display board, while 
the upload method of User messages is different, that will be mentioned in Part 7 
 
 
How LiftCentral™ changes message properties 
Changing message properties of a message 
You select a message from the document window and double-click the message; or “Properties…” 
command in Message Menu from the menu bar; or shortcut key “Ctrl+Enter”; or click your right mouse 
button and then select “Properties…” command from the pop-up menu.  It will show you a Message 
Properties dialog box, which consists of 3 sections.  The following paragraphs will describe all of the 
sections that are identified in Figure 4-5. 
 

 
Figure 4-5 Message properties dialog box 
 
Message Content Section 
There are two radio buttons, which are “Text” and “Graphics”.  They help you to input the content of 
message that will be displayed on the LiftView™.  When you choose “Text” button, keyboard becomes 
your input peripheral.  Otherwise, the content of message becomes a graphic mode input.  A new dialog 
box will pop-up. 
 

 
Figure 4-6 Dialog box for graphic mode input 
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If the content of message in the text box is empty, the above dialog box will not display.  Moreover, it will 
display a warning dialog box. 
 

 
Figure 4-7 Warning dialog box 
 
Using keyboard to input text is very easy, but you need to keep watch for the display area of your 
LiftView™ display, since the display mode of alarm and user message is scrolling.  The maximum number 
of English characters is 256, and that of Chinese characters is 128 (except LV-10.07-VL series, 
LV-10.14-VL series, LV-16.16-M series, LV-16.32-M series and LV-32.16-M series of LiftView™ display 
board).  However, the display mode of floor message is fixed in the center of the display board.  
Therefore, the number of characters is dependent on the display area. 
 
The message content is shown on the Message Text Column.  For example, when you type in “LEVEL 6 
六樓” that will show on the Message Text Column.  While the message content is in graphic mode, the 
message text column will display “Image: …“. 
 
Event Setting Section 
Event setting is divided into three parts: Floor Trigger, Alarm and User. 
 
Floor Trigger part is used for the setup of a floor message.  It consists of two parts that are Trigger and 
Short Name. 
 
Trigger is related to the floor input signals of lift controller.  There are binary inputs and dry contract inputs.  
Their maximum number of floor messages is 128 (range of Trigger is T.0 to T.127) and 16 (range of 
Trigger is T.0 to T.15) respectively.  For example, the lift signal for “Ground 地下” is “0”, and thus 
Trigger must set to be “0”. 
 
Short Name is a short term representing a floor, when the message is a floor message.  For example, 
when you input “Level 1 一樓” into Message Text Section, you can input “1” into the Short Name. 
 
Notes: LV-10.07-VL series, LV-10.14-VL series, LV-16.16-M series, LV-16.32-M series and LV-32.16-M series display board only 
show the short name for floor message.  Moreover, it is only numeric or capital letter.  The text in the message content section is 
ignored.  Another series of display board show the short name, when they are showing alarm messages.  Their short name can 
be numeric, capital or small letter. 
 
Alarm part is used for the setup of an alarm message (range of Alarm messages is A.1 to A.10). 
 
Notes: For our standard product, alarm message A1 to A4 have priority.  A1 is the highest and A4 is the lowest.  For alarm 
messages A5 to A10, the alarm message will display alternately if either one of them is on. 
 
 

Alarm 
No. A.1 A.2 A.3 A.4 A.5 A.6 A.7 A.8 A.9 A.11

Priority Highest 
Priority 

 Lowest 
Priority No Priority 

 
Gradually to demonstrate showing alarm messages: 
Step 1. A5 and A7 are on, the display board shows the alarm messages alternately. 
Step 2. A4 alarm message is on, A5 and A7 are still on.  The display board only shows the A4 alarm 

message.  The alarm A5-A11 message is ignored. 
Step 3. A1 alarm message is on, A4, A5 and A7 are still on.  The display board only shows the A1 alarm 

message.  The A2-A11 alarm message is ignored. 
Step 4. A1 and A4 are released, the display board shows A5 and A7 alarm messages alternately. 
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User part is used for the setup of a user message.  When showing user message, all of the alarm 
messages are ignored.  The display board shows user message one at a time. 
 
Notes: LV-10.07-VL series, LV-10.14-VL series, LV-16.16-M series, LV-16.32-M series and LV-32.16-M series display board do not 
show the user message. 
 
The event setting will be shown in the Short Name Column and Event Column. 
 
Valid Group 
There are 8 available display destination groups (G0~G7).  All display destination groups are selected in 
the default dialog box.  A group is used to identify the message to be inside and/or outside the lift.  
Group Selection Column will show which group you have selected. 
 
Changing message properties of a group of messages 
When you want to change message properties of a group of message (e.g. trigger, valid group), the group 
of message must be in same type of category.  You can select the group of message, and then follow the 
previous method to open the message properties dialog box.  Name of dialog box is changed to “Global 
Properties”. 
 

 
Figure 4-8 Global properties dialog box 
 
From the figure 4-8, Event Setting Section is changed to Event Offset Setting.  Moreover, only Event 
Offset Setting Section and Valid Group Section can be operated. 
 
When you select a group of floor message, the floor trigger part in event offset setting section will be visible.  
You type in either negative or positive integer for the offset value. 
 
For example, the trigger range of the selected group is from T.0 to T.4.  Then you type in –2 in the floor 
trigger part.  The result is shown in the following table. 
 

Message Original Trigger After Offset 
Ground 地下 T.0 T.126 
Level 1 一樓 T.1 T.127 
Level 2 二樓 T.2 T.0 
Level 3 三樓 T.3 T.1 
Level 4 四樓 T.4 T.2 
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You can entirely set a group of message that will show inside and/or outside the lift by using valid group in 
global properties dialog box.  If you set valid group like the following figure, the selected messages will 
only be shown in Group 3, 4 and 5. 
 

 
Figure 4-9 Valid groups setting 
 
Setting a group of alarm message is the same as that of floor message.  In the global properties dialog 
box, user message only sets the valid group. 
 
How to use graphic mode to modify a message? 

p Drawing 
Toolbar 

 
From the figu
mouse pointe
 
Position of 

 
This shows th
 
Edit Area 

 
Whatever the
Show the
osition of

mouse
pointer
 

Edit Area 

Figure 4-10 Dialog for graphic mode input 

re 4-10, it is divided into 3 parts.  At the top of the dialog box, it shows you the position of 
r.  The middle part is the Drawing Toolbar and the bottom part is the Edit Area. 

Mouse Pointer 
 

e position of your mouse pointer. 

 

 colour scheme of file setting may be, the edit area displays black and white colour. 
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Drawing Toolbar 
 

 
The drawing toolbar provides quick mouse access to painting, drawing and other image related commands 
for graphic mode input. 
 
First, we need to introduce the feature of mouse button setting to you.  Graphic mode input uses both the 
left and right mouse buttons on selection, painting, and drawing operations. 
 
The documentation uses the terms primary and secondary to refer to these mouse buttons.  When 
Windows is configured for Right-handed operation, the primary button is the left mouse button (and the 
secondary is the right button).  When Windows is configured for Left-handed operation, primary button 
means right button (and secondary means left).  Whichever configuration is used, the primary mouse 
button is the one you use to access window menus, click on buttons, etc. 
 
When using the painting tools, the primary mouse button uses the foreground colour and the secondary 
buttons use the background colour.  In this input mode, the foreground colour is black and the 
background colour is white. 
 

 Cut Tool 
Remove selected image from the edit area and store it on the clipboard. 

 Copy Image Tool 
Copy the selection to the clipboard. 

 Paste Image Tool 
Insert the contents of the clipboard to the edit area. 

 Grid Tool 
Graphic mode input can display a grid to aid in the process of painting and drawing.  The Grid 
helps you position drawings at precise distances and compare the position of different parts of 
the image.  Some painting, drawing, and selection operations can be constrained to operating
over grid lines, making it easier to paint/draw in straight lines, squares and circles. 
 
To display / hide the grid 
Click on the Toggle Grid icon on the drawing toolbar to show / hide the grid. 

 Zoom Tool 
When the mouse pointer is shaped as a magnifying glass, you can increase/decrease the 
zoom level continuously. 
 
To increase the zoom level (more detail): 
Use the Zoom tool and click on the primary button. 
 
To decrease the zoom level (less detail): 
Use the Zoom tool and click on the secondary button. 

 Hand Scroller Tool 
Do one of the following: 
1. Click on one of the scroll bars and move the scroll bar cursor to the edit area you want.  

You can achieve that by dragging the scroll bar cursor or clicking on one of the scroll bar’s 
arrows.  

2. Use the Hand Scroller tool, the mouse pointer takes the shape of a hand.  Click either 
mouse button on the edit area, and move it around. 
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 Selection Tool 
1. Click on the Selection tool. 
2. Position the mouse over the image, click on the starting point and drag the mouse.  A 

selection marquee with the selected shape will be defined as you drag the mouse. When 
you surround the area that you want to select, release the mouse button. 

 
Option for Selection tool is: 
 It acts as a rubber.  After you select the unwanted area, you can put it away from the edit 

area.  The unwanted area is erased. 
 Once you have selected an area, you can use  option to resize the selected area. 

 Fill Tool 
It determines which pixels will be painted in the fill operation. 
 
Foreground colour: click the primary mouse button. 
Background colour: click the secondary mouse button. 

 Pencil Tool 
The pencil tool is similar to the brush tool. 
 
Foreground colour: click the primary mouse button. 
Background colour: click the secondary mouse button. 

 Line Tool 
To use the Line Tool, click a mouse button on the starting point of the line you would like to 
draw.  Without releasing the button, drag the mouse pointer to the ending point of the line, and 
only then, release the button.  The line is surrounded by a broken line.  It means that the line 
is not merged to the edit area, until you click Line tool icon again.  When it is not merged to 
the edit area, you can change the length, width, colour, position or sharp etc. 
 
To select which painting colour should be used: 
Black colour: click the primary mouse button. 
Background colour: click the secondary mouse button. 
 
Option for Line tool is: 
Select the desired line width  option. 

 Rectangle Tool 
To use the Rectangle Tool, click a mouse button on the active image and drag it to draw a 
rectangle or square.  When the size of the rectangle / square is reached, release the mouse 
button.  The rectangle / square is also surrounded by a broken line.  It means that the 
rectangle / square is not merged to the edit area, until you click Rectangle tool icon again.  
When it is not merged to the edit area, you can change the size, colour, or position etc. 
 
To select which painting colour should be used: 
Foreground colour: click the primary mouse button 
Background colour: click the secondary mouse button 
 
Options for the Rectangle tool are: 
 Select the desired line width  option for the rectangle / square borders 
 Select  option to fill the rectangle / square with the same colour used for the border.  

When this option is not selected, rectangle / square is hollow. 
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 Circle Tool 
To use the Circle Tool, click a mouse button on the active image and drag it to draw a circle.  
When the size of the circle is reached, release the mouse button.  The circle is also 
surrounded by a broken line.  It means that the circle is not merged to the edit area, until you 
click Circle tool icon again.  When it is not merged to the edit area, you can change the size, 
colour, or position etc. 
 
To select which painting colour should be used: 
Foreground colour: click the primary mouse button 
Background colour: click the secondary mouse button 
 
Options for the Circle tool are: 
 Select the desired line width  option for the circle borders 
 Select  option to fill the circle with the same colour used for the border.  When this 

option is not selected, circle is hollow. 

 Text Tool 
To use the Text Tool, click the mouse on the active image, where you would like to add the text. 
Text is created using the options currently set for the Text Tool. 
 
Steps of Adding Text to the Image: 
1. Using  option 
 

 
 
2. The Text Editor dialog box allows you to type the text you would like to add.  On the other 

hand, use “Import…” button to import text file (*.txt or *.rtf). 
3. You click  icon on the edit area.  The input text will display on the edit area, but it is 

also surrounded by broken line.  Thus, you need to click Text tool again. 
 
If the text is longer than the edit area, you can use  option to increase the edit area (input 
position number).  Otherwise, you can use it to decrease the edit area (input negative 
number).   
 

 
 Font Tool 

Set this option to the font you would like to use. 
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How to change the font format of messages? 
The default font style for floor and alarm message is System, bold type, and font size 10 points.  The 
default font style for short name is Arial, regular type and font size 8 points. 
 
You use  icon from the toolbar, or “Font Setup” command in Message Menu from the menu bar, or 
shortcut key “Ctrl + F” to change the font size and type for message categories. 
 

 
Figure 4-11 Font setup dialog box 
 
From the figure 4-11, the left hand side is the message categories.  The right hand side shows the font 
format for particular category.  When you press any category, it will show you Font Dialog Box. 
 

 
Figure 4-12 Font dialog box 
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USING LIFTSPEAKER SOUND FILE IN LIFTCENTRAL™ 
 
View of Document Window for LiftSpeaker Sound File 
 

 
Figure 5-1 The document window for LiftSpeaker Sound File 
 
Starting at the top of the document window are several columns: Slot column, Event column, Looping 
Selection column and Filename of Sound File column. 
 
Slot column provides position for you to insert sound track to different events. 
 
Event column acts like the event column of LiftView Message File.  However, it only has floor trigger and 
alarm trigger. 
 
Looping selection column indicates whether to repeat the inserted sound track. 
 
Filename of sound file column shows the name of the sound file that is inserted into the slot. 
 
How LiftCentral™ changes slot properties? 

 
Figure 5-2 Slot properties dialog box 

 
The method of changing slot properties is similar to changing message properties.  The difference is 
selecting “Properties…” command in the Slot Menu from the menu bar, since it has not Message Menu.  
The following paragraphs will describe all of the sections that are identified in Figure 5-2. 
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Let’s start at the right hand corner, you see  icon.  It is used for selecting file.  When you press the 
icon, a dialog box appears.  It prompts you to select sound file.  The type of sound file is *.aff, *.au, *.mp3, 
*.paf, *.svx and *.wav. 
 

 
Figure 5-3 Browse file dialog box 
 
Once you select sound file, the name of the file will be shown on “Filename” option and Filename of 
Sound File column of the document window. 
 
There is “Clear” button whose function is to clear the selection of sound file.  When you press it, it clears 
the filename in the “Filename” option. 
 
If your want to repeat playing the selected sound file, you need to select Looping Setting Section.  The 
default mode of looping setting is not selected.  The status of this option is shown on the Looping 
selection column of the document window. 
 
Event Setting Section is divided into 2 parts, which are Floor Trigger Part and Alarm Part.  If your 
system also comprises LiftView™ display board, you must set the trigger number in this part the same as 
that of the LiftView Message File.  On the other hand, the LiftSpeaker™ digital voice announcer can be 
stand-alone module or work in conjunction with LiftView™ display board. 
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INTRODUCTION OF UPLOADING MEDIA 
 
There are two media for uploading file, they are RS-232 to RS-485 converter or Infrared. 
 

RS-232 to RS-485 Converter 
Using RS-232 to RS-485 converter for uploading, it must be connected to Host PC and LiftMaster™ 
controller. 
 

 
 

Figure 6-1 RS-232 to RS-485 converter 
 
One side of the RS-232 to RS-485 Converter is connected to Host PC’s RS-232 serial port.  The other 
side is programmable terminal A (PA) and programmable terminal B (PB) that is connected to LiftMaster™ 
controller’s PA and PB. 
 

 
 

Figure 6-2 Pin out of LM-3201-1 
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Infrared Medium (Ir Medium) 
Infrared as uploading medium is preferable to bringing Notebook to site for updating your LiftView™ 
system.  Infrared medium consists of a loader, a receiver and a uploading cable. 
 

 

 
 

 
Figure 6-3 Infrared loader Figure 6-4 Infrared receiver 

 
Figure 6-5 Uploading cable 

 
Infrared Loader (Ir Loader) 
 

Status of Ir Loader Colour of Status Indicator
Memory of it is empty RED 

Normal Mode GREEN 
Processing Mode Orange 

 
Infrared Receiver (Ir Receiver) 
Ir receiver is connected to the LiftMaster™ controller.  One is connected to 5V output (Vo+ Vo-) of 
LiftMaster™.  Another is connected to programmable terminal A (PA) and programmable terminal B (PB) 
of LiftMaster™. 
 
Uploading Cable 
One end of the cable is connected to Host PC’s RS-232 serial port.  Another end is connected to the Ir 
loader’s data input socket.  
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UPLOADING LIFTVIEW MESSAGE FILE VIA DIFFERENT MEDIA 
 
There are two media for uploading LiftView Message File, they are RS-232 to RS-485 converter or 
Infrared Loader and Receiver.  From the above chapter, we have mentioned LiftView message file 
consists of three types of message.  These are: 
 

  Floor messages; 
 Alarm messages; and 
 User message. 

 
Floor and Alarm messages use the same type of method and both types of media to upload to the 
LiftView™ display board.  The upload method of User messages is different.  Let’s go to start using 
RS-232 to RS-485 converter for uploading LiftView Message File. 
 
 
Uploading Floor and Alarm Messages via RS-232 to RS-485 Converter 
1. Setup your LiftView™ system with LiftView™ display boards. 
2. Connect RS-232 to RS-485 converter to the Host PC and LiftMaster™ controller. 
3. Start your LiftCentral™ program and open the LiftView Message File. 
4. Setup your output port to connect to the RS-232 to RS-485 converter. 
5. Turn on the whole LiftView™ system. 
6. When everything is ready, you can click  icon from the toolbar or “Program ROM…” command in 

File menu from the menu bar, or “Ctrl+M”. 
7. LiftCentral™ will check the content and short name of floor messages.  If they are longer than the 

display area of model that you have selected in File Setting, a warning dialog box will tell you which 
message is having a problem.  The warning dialog will show only 20 items.  If it is more than 20, it will 
show you “…” after the last item of warning message.  If not, that will go to process 8. 

 

 
Figure 7-1 Warning dialog box for uploading message problem 

 
8. Once you select the programming command, a dialog box will prompt you to ensure you have already 

setup your system and tell you this process may take up to 90 seconds. 
 

 
Figure 7-2 Prompted to ensure programming your system 
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If you click OK, the uploading process will continue.  Moreover, the mouse cursor will change to .  
Message Upload dialog boxes were shown.  Moreover, the LiftView™ display boards in your system 
put out the light.  When the process finishes, the mouse cursor will become normal and display boards 
will turn on again.  If you click CANCEL, the uploading process is aborted. 
 

 
Figure 7-3 Message upload dialog box 

 
Uploading User Message via RS-232 to RS-485 Converter 
From the above section, we have mentioned that user message is real-time message.  LiftView™ 
displays show the user message immediately when you upload it.  While displaying the user message, all 
of the alarm message will be ignored.  As the characteristic of user message, it has special commands for 
upload to the LiftView™ displays.  Moreover, it only uses RS-232 to RS-485 converter as upload medium. 
 
Commands for Uploading User Message 

 Upload the user message to the display board. 
Shortcut : Ctrl+D 

 Stop showing the user message on the display board.  The user message is being shown until 
you press this command that will cancel the show command of user message. 
Shortcut : Ctrl+T 

 
Steps for Uploading User Message 
1. Setup your LiftView™ system with LiftView™ display boards. 
2. Connect RS-232 to RS-485 converter to the Host PC and LiftMaster™ controller. 
3. Start your LiftCentral™ program and open the LiftView Message File. 
4. Setup your output port that is connected to the RS-232 to RS-485 converter. 
5. Turn on the whole LiftView™ system. 
 

 
Figure 7-4 Selection of user message 

 
6. Select the user message from the document.  If you do not select any user message from the 

document, the  icon is invisible for use. 
7. When everything is ready, you can click  icon from the toolbar or “Upload” command in Message 

menu from the menu bar, or “Ctrl+U”. 
8. Once you select the Upload command, a dialog box will prompt you to ensure your system need to be 

change. 
 

 
Figure 7-5 Prompted to ensure your system need to be change 
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Stop Showing User Message 
It is similar to the process for uploading user message, only Step 7 is changed to use  icon.  Once the 
command is complete, the LiftView™ display board will become normal (showing the floor message or 
alarm message). 
 
 
Uploading Floor and Alarm Messages via Ir Medium 
Infrared medium is only used for uploading Floor and Alarm Message in the LiftView Message File.  
Using this medium for uploading LiftView Message File, we must do 2 processes. 
 
1. Upload the LiftView Message File from your Host PC to the Infrared loader. 
2. Upload the information from the Infrared loader to your LiftView™ system via Infrared receiver and 

LiftMaster™ controller. 
 
Process 1 – from host PC to Infrared loader 
1. Connect uploading cable to the Host PC and Ir loader. 
2. Start your LiftCentral™ program and open the LiftView Message File. 
3. Setup your output port that is connected to the uploading cable. 
4. Turn on the Ir loader. 
5. When everything is ready, you can click  icon from the toolbar or “Program ROM…” command in 

File menu from the menu bar, or “Ctrl+M”. 
6. LiftCentral™ will check the content and short name of floor messages.  If they are longer than the 

display area of model that you have selected in File Setting, a warning dialog box will tell you which 
message is having a problem.  The warning dialog will show only 20 items.  If it is more than 20, it will 
show you “…” after the last item of warning message.  If not, that will go to process 8. 

 

 
Figure 7-6 Warning dialog box for message display problem 

 
7. Once you select the programming command, a dialog box will prompt you to ensure you have already 

setup your system and tell you this process may take up to 90 seconds. 
 

 
Figure 7-7 Prompted to ensure programming your system 

 
If you click OK, the uploading process will continue.  Moreover, the mouse cursor will change to .  
Moreover, Message Upload dialog boxes were shown.  Once the process is complete, the mouse 
cursor will become normal.  If you click CANCEL, the uploading process is aborted. 
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Figure 7-8 Message upload dialog box 

 
8. The colour of status indicator of the Ir loader will change from RED / GREEN to ORANGE during the 

programming process.  Once the process is complete, the colour of status indicator will become 
GREEN, it is normal mode. 

 
Process 2 – from the Ir loader to your LiftView™ system 
1. Setup your LiftView™ system with LiftView™ display boards. 
2. Connect Ir receiver to the LiftMaster™ controller. 
3. Turn on the whole LiftView™ system and the Ir loader. 

Press the Upload button on the Ir loader for a few seconds then you can release the button.  The 
colour of status indicator of the Ir loader will change from RED / GREEN to ORANGE during the 
programming process.  However, you must hold the Ir loader to target on the Ir receiver.  The 
LiftView™ display boards in your system put out the light, once the process is complete. 

 
Once the process is complete, the colour of status indicator will become GREEN, it is normal mode. 
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UPLOADING LIFTSPEAKER SOUND FILE VIA DIFFERENT MEDIA 
 
Uploading media for LiftSpeaker Sound File is the same as that for LiftView Message File.  They are 
RS-232 to RS-485 converter or Infrared Loader and Receiver.  The upload method of LiftSpeaker 
Sound File is similar to that of LiftView Message File, only changes the LiftView™ display boards to 
LiftSpeaker™ digital voice announcer.  The difference is LiftSpeaker™ digital voice announcer must have 
a SOUND ROM that provides the source of the pre-recorded announcement.  Let’s go to create SOUND 
ROM. 
 
 
How do you create sound ROM? 

 
Figure 8-1 LiftSpeaker™ digital voice announcer 

 
When you create sound ROM, you must have equipment that can program Atmel / Winbond 29C-series 
EEPROM (e.g. ALL-11 programmer).  The sound ROM is on position U7 of LiftSpeaker™ digital voice 
announcer.  You must take it out from the LiftSpeaker™ digital voice announcer carefully.  What file will 
you program into the EEPROM?  The file is a binary file (*.bin), which is generated by LiftCentral.  We 
show you how to generate the binary file step by step. 
 
Generate Binary File Step by Step 
1. Start your LiftCentral™ program and open the LiftSpeaker Sound File. 
2. You can click  icon from the toolbar or “Upload” command in Message menu from the menu bar, or 

“Ctrl+U”. 
3. LiftCentral™ will check the path of the sound files that you have imported into each slot.  If the path of 

sound files is not the same as your LiftCentral™ (e.g. C:\Program Files\LiftCtrl\), a warning dialog box 
will show you which sound files are in trouble and the compilation process is aborted.  If not, that will go 
to step 4. 

 

 
Figure 8-2 Warning dialog box for the path of sound file error 

31 



 

4. You will be prompted to select the folder into which binary file will be saved.  The binary filename is the 
same as your LiftSpeaker™ Sound File.  Such as the filename of LiftSpeaker™ Sound File is 
LSDemo.lvs, then the filename of binary file is LSDemo.bin. 

 

 
Figure 8-3 Prompted to select folder for saving the binary file 

 
“Creation of ROM file C:\Program Files\LiftCtrl\LSDemo.bin completed!” message will be shown on the 
status bar of the document. 
 
Once you generate the binary file, use your EEPROM programmer to program the 29C-series EEPROM.  
Then put it back to position U7 of the LiftSpeaker™ digital voice announcer.  When the sound ROM is 
ready, you should do the same process of LiftView Message File, which is using RS-232 to RS-485 
converter or Ir kit to upload the LiftSpeaker Sound File to the digital voice announcer. 
 
 
Uploading via RS-232 to RS-485 Converter 
1. Setup your LiftView™ system with LiftSpeaker™ digital voice announcer. 
2. Connect RS-232 to RS-485 converter to the Host PC and LiftMaster™ controller. 
3. Start your LiftCentral™ program and open the LiftSpeaker Sound File. 
4. Setup your output port that is connected to the RS-232 to RS-485 converter. 
5. Turn on the whole LiftView™ system. 
6. When everything is ready, you can click  icon from the toolbar or “Program ROM…” command in 

File menu from the menu bar, or “Ctrl+M”. 
7. Once you select the programming command, a dialog box will prompt you to ensure you have already 

connected your output device to selected serial port. 
 

 
Figure 8-4 Prompted to ensure the RS-232 to RS-485 converter is connected to selected serial port 

 
8. If you click OK, the uploading process will continue.  Moreover, the mouse cursor will change to .  

Once the process is complete, the mouse cursor will become normal.  If you click CANCEL, the 
uploading process is aborted. 
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Uploading via Ir Medium 
Uploading LiftSpeaker Sound File using infrared medium is also the same as LiftView Message File, also 
need to do 2 processes. 
 
1. Upload the LiftSpeaker Sound File from your Host PC to the Infrared loader. 
2. Upload the information from the Infrared loader to your LiftSpeaker™ digital voice announcer via 

Infrared receiver and LiftMaster™ controller. 
 
Process 1 – from host PC to Infrared loader 
1. Connect uploading cable to the Host PC and Ir loader. 
2. Start your LiftCentral™ program and open the LiftSpeaker Sound File. 
3. Setup your output port that is connected to the uploading cable. 
4. Turn on the Ir loader. 
5. When everything is ready, you can click  icon from the toolbar or “Program ROM…” command in 

File menu from the menu bar, or “Ctrl+M”. 
6. Once you select the programming command, a dialog box will prompt you to ensure you have already 

connected your output device to selected serial port. 
 

 
Figure 8-5 Prompted to ensure the uploading cable is connected to selected serial port 

 
If you click OK, the uploading process will continue.  Moreover, the mouse cursor will change to .  
Once the process is complete, the mouse cursor will become normal.  If you click CANCEL, the 
uploading process is aborted. 

 
7. The colour of status indicator of the Ir loader will change from RED / GREEN to ORANGE during the 

programming process.  Once the process is complete, the colour of status indicator will become 
GREEN, it is normal mode. 

 
Process 2 – from the Ir loader to your LiftView™ system 
1. Setup your LiftView™ system with LiftView™ digital voice announcer. 
2. Connect Ir receiver to the LiftMaster™ controller. 
3. Turn on the whole LiftView™ system and the Ir loader. 

Press the Upload button on the Ir loader for a few seconds then you can release the button.  The 
colour of status indicator of the Ir loader will change from RED / GREEN to ORANGE during the 
programming process.  However, you must hold the Ir loader to target on the Ir receiver. 

 
Once the process is complete, the colour of status indicator will become GREEN, it is normal mode. 

33 


	Table of Contents
	Congratulation
	Read This First!
	LiftView™ System Components
	How to Install LiftCentral™ Software?
	Minimum Requirements of Your Computer
	Installing LiftCentral™ Software

	The Launch and Tour
	Starting LiftCentral™ through the START Button
	Starting LiftCentral™ with a File
	A Tour of the LiftCentral™ Screen
	Title Bar
	Click To
	Menu Bar
	Toolbar
	Status Bar



	Common Functions of LiftCentral™
	Creating New Document
	Opening Existing Files
	Option
	Look in

	Saving Active Document
	Inserting New Message / Slot
	Deleting Existing Message / Slot
	Port Setup for Uploading File to Your System

	Using LiftView Message File in LiftCentral™
	Introduction of LiftView Message File
	View of Document Window
	File Setting for LiftView Message File
	Model of LiftView Display Board
	LiftMaster Selection (Optional Function)
	Colour for Different Type Information

	What are the message categories?

	How LiftCentral™ changes message properties
	Changing message properties of a message
	Message Content Section
	Event Setting Section
	Valid Group

	Changing message properties of a group of messages
	How to use graphic mode to modify a message?
	Position of Mouse Pointer
	Edit Area
	Drawing Toolbar
	Cut Tool
	Copy Image Tool
	Paste Image Tool
	Grid Tool
	Zoom Tool
	Hand Scroller Tool
	Selection Tool
	Fill Tool
	Pencil Tool
	Line Tool
	Rectangle Tool
	Circle Tool

	How to change the font format of messages?


	Using LiftSpeaker Sound File in LiftCentral™
	View of Document Window for LiftSpeaker Sound File
	How LiftCentral™ changes slot properties?

	Introduction of Uploading Media
	RS-232 to RS-485 Converter
	Infrared Medium (Ir Medium)
	Infrared Loader (Ir Loader)
	Infrared Receiver (Ir Receiver)
	Uploading Cable



	Uploading LiftView Message File Via Different Media
	Uploading Floor and Alarm Messages via RS-232 to RS-485 Conv
	Uploading User Message via RS-232 to RS-485 Converter
	Commands for Uploading User Message
	Steps for Uploading User Message


	Stop Showing User Message
	Uploading Floor and Alarm Messages via Ir Medium
	Process 1 – from host PC to Infrared loader
	Process 2 – from the Ir loader to your LiftView™ system



	Uploading LiftSpeaker Sound File Via Different Media
	How do you create sound ROM?
	Generate Binary File Step by Step

	Uploading via RS-232 to RS-485 Converter
	Uploading via Ir Medium
	Process 1 – from host PC to Infrared loader
	Process 2 – from the Ir loader to your LiftView™ system





